
O`ZBЕKISTON RЕSPUBLIKASI OLIY VA O`RTA MAXSUS TA'LIM VAZIRLIGI
TOSHKЕNT TO`QIMACHILIK VA YЕNGIL SANOAT INSTITUTI

Informatika va axborot texnologiyalari kafеdrasi

«Informatika va informatsion texnologiyalari» fanidan

Mavzu: Adobe Photoshop dasturida rasmni qayta
ishlash texnologiyalari va unda har xil effektlar yaratish.

10-15 guruh talabasi

Bajardi: Ochilova M.

Qabul qildi: Qulmurodov M.

Toshkent 2016-yil
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2.1 Adobe Photoshop dasturining ishlab chiqilish tarixi

2.2 Adobe Photoshop grafik muharriri muhiti

2.3 Adobe Photoshop dasturning ish qurollari.

3. Amaliy qism
3.1 Deraza oynasidagi yozuv effekti

3.2 Fotosurat akvarelda chizilganlik effekti

3.3 Rasmda dekorativ naqsh effektini hosil qilish
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Kirish
O’zbekiston Respublikasida chuqur keng ko’lamli isloxotlar amalga oshirilar

ekan,  uzluksiz iqtisodiy  ta’lim  tizimini  shakllantirishga  birinchi  darajali
axamiyat berilmoqda.  Davlatimiz  raxbari  I.A.Karimov  ta’kidlaganlaridek:  “Biz
kiyin sharoitda  kelajagimiz  poydevorini  qurib  oldik.  Bunga  o’rnimizga
keladigan  yosh avlod qanday  baxo beradi, loyixalarimizni  taroziga solib  ko’rib
nima  deydi?-  Xarbirimiz  ana  shu  savolni  dilga  tugib  mehnat  qilishimiz,
yuqori  natijalarga erishishimiz lozim. Mening ishonchim komilki, O’zbekiston
xalqi farovon turmush kechiradigan buyuk davlat bo’ladi”.

Kelajagi buyuk  davlatni  qurish  tafakkuri,  dunyoqarashi  o’zgargan
xodimlarimiz, mutaxasislarimizga ko’p jixatdan bog’liqdir. Yangicha fikrlaydigan,
bozor  munosabatlarida  muvaffaqiyatli  xo’jalik  yuritadigan  yuksak  malakali,
chuqur  bilimli  mutaxasislarni  tayyorlash  davr  talabi  bo’lib  qoldi.
Mamlakatimiz rivojlangan  davlatlar  qatoridan  mustaxkam  o’rin  egallashi
uchun  zamonaviy kompyuter  texnologiyalarini  xayotimizning  barcha
jabxalariga,  ayniqsa iqtisodiyotga keng joriy etish zarur.

O’zbekiston  Respublikasida  informatikani  rivojlantirish,  tamoyillari
quyidagilardan iborat:

Birinchidan,  zamonaviy  axborot  texnologiyasini  rivojlantirish,  davlat
muassasalari  va  xo’jalik  sub’ektlari,  muassasasalari  va  xo’jalik  sub’ektlari,
muassasa va tashkilotlar, xususiy shaxslar uchun axborot xizmatini yo’lga qo’yish:

Ikkinchidan,  iktisodiyot,  fan,  ta’lim,  ijtimoiy  soxada  axborot  tizimlarini
shakllantirishga ko’maklashish;

Uchinchidan, Respublikaning jaxon axborot tizimlari va xalqaro tarmoqlariga
ulanishini ta’minlash;

Ana  shu  uch  asosiy  tamoyillardan  kelib  chiqan  xolda  quyidagi  asosiy
vazifalar xal etilishi talab kilinmokda:

A)  axborotga  tovar  sifatida  karashni  ta’minlovchi  va  rag’batlantiruvchi
xukukiy va iktisodiy me’yorlarni joriy etish;

B)  axborotni  takdim  etish,  saqlash  va  uzatishga  oid  xalqaro  standartlarga
rioya kilish.
V)  Informatika  industriyasini  shakllantirish  va  rivojlantirish,  yangi

axborot
texnologiyalari,  kompyuter  va  rivojlangan  telekommunikatsiya  texnikasi,
dasturiy vositalar  ishlab  chiqarishni  o’zlashtirish,  ma’lumotlar  bazasi  va
eksport  ta’minoti xizmati bozorini shakllantirish;

G) ma’lumotlarni uzatish milliy axborot hisoblash tarmog’i, davlat xizmati va
tuzilmalari idoraviy tarmog’i, vazirlik va idoralar, korxona va tashkilotlar, xususiy
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va  tijorat  lokal  axborot  tarmoqlarini,  ilmiy-texnikaviy   fanlar,  avtomatlashgan
ish o’rinlarini yaratish va rivojlantirish;

V) axborot tizimlari eng yangi modellarini yaratish soxasidan fundamental va
amaliy tadqikotlarni rag’batlantirish va qo’llab-quvvatlash,

E)  informatika  vositalaridan  foydalanuvchilarni  tayyorlashning  uzluksiz
tizimini takomillashtirish.

Informatikaning  inson  faoliyatining  mustaqil  soxasi  sifatida  ajralib
chiqishi birinchi navbatda kompyuter texnikasining rivojlanishi bilan bog’liq.
Bunda asosiy xizmat  mikroprotsessor  texnikasiga  to’g’ri  proportsional  keladi,
uning  paydo bulishi 70-yillar o’rtalarida ikkinchi elektron inqilobni boshlab berdi.
SHu davrdan boshlab  xisoblash  mashinalarining  element  negizini  integral
chizma  va mikroprotsessorlar  tashkil  etdi.  Informatika  atamasi  nafakat
kompyuter  texnikasi yutuklarini  aks  ettirish  va  foydalanish,  balki  axborotni
uzatish  va  qayta  ishlash jaraenlari bilan xam bog’lanadi.

Informatika  axborotni  qayta  ishlash,  ularni  qo’llash va ijtimoiy
amaliyotning turli  soxalariga  ta’sirini  EXM  tizimlariga  asoslangan  xolda
ishlab  chiqish, loyixalash, yaratish, ilmiy va muxandislik Fani soxasidir.

Informatika bu jixatdan axborot modellarini ko’rishning umumiy metadologik
tamoyillari  ishlab  chiqishga  yo’naltirilgan.  SHu  bois  axborot  uslublari  ob’ekt,
xodisa,  jarayon  va  xokazolarni  axborot  modellari  yordamida  bayon  etish
imkoniyatiga egadir.

O’zbekiston  Respublikasi  mustaqillikka  erishganidan  sung,  rivojlanishning
yukori  boskichiga   kutarildi.  SHu  borada  kompyuter  texnologiyalarining  ishlab
chiqarishga,  iktosodiyotga   va  biznesga  tadbiki  kengayib  bormokda.  1997
yilda O’zbekiston Respublikasi Oliy Majlisining tukkizinchi  sessiyasida qabul
qilingan «Ta’lim  to’g’risida  »  va  «Kadrlar  tayerlash  buyicha   Milliy  dastur
to’g’risida» to’g’risida  qonunlarida,  O’zbekiston  Respublikasi   Oliy  va  O’rta
iaxsus  ta’lim vazirligining karorlari va buyruqlarida  (jumladan, 11.4-sonli xa’at
karori.

1996  yil  27  noyabr  yuqori  texnologiyalarni,  xususan   informatsion
texnologiyalarni  va axborotni qayta ishlash  tizimlarini xaytga tadbik etishga katta
e’tibor berilgan.

Raqobatbardosh iqtisodiet  asosan yuqori malakali kadrlar tayyorlashda ta’lim
jarayonining  informatsiyalashtirilganligi  va  kompyuterlashtirilganligi  muxim
axamiyatga  ega ekanligi ko’rsatilgan.

Informatikaning  inson  faoliyatining  mustaqil  soxasi  sifatida  ajralib
chiqishi birinchi navbatda kompyuter texnikasining rivojlanishi bilan bog’lik.
Bunda asosiy xizmat  mikropretsessor  texnikasiga  to’g’ri  keladi,  uning  paydo
bulishi  70-yillar urtalarida ikkinchi elektoron inkilobini boshlab berdi.
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Shu  davrdan  boshlab  xisoblash  iashinalarining  element  negizini  integral
chizma va mikroprotsessorlar tashkil etdi. Informatika atamasi nafakat kompyuter
texnikasi  yutuklarini  aks  ettirish  va  foydalanish,  balki  axborotni  uzatish  va
qayta ishlash jaraenlari bilan xam boglanadi. Informatika  axborotni  qayta  ishlash,
ularni  kullash  va  ijtimoiy  amalietning turli  soxalariga  ta’sirini  EXM
tizimlariga  asoslangan  xolda  ishlab  chiqish, loyixalash,yaratish,  baxolash,
ishlashning  turli  jixatlarini  urganuvchi  kompleks ilmiy va muxandislik fani
soxasidir. Informatika-kompyuterlar  yordami  va  ularni  qo’llash  muxiti
vositasida axborotni yangilash jaraenlari bilan bog’liq inson faoliyati soxasidir.
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Nazariy qism
Adobe Photoshop dasturining ishlab chiqilish tarixi

Adobe Photoshop dasturining ishlab chiqilgan sanasi birorta kalendarda qayd

etilmagan. Biz ishlatadigan Adobe Photoshop dasturining 2005-yilda bir yilligi

nishonlandi. Bundan 17 yil oldin, fevral oyida, «Adobe» kompaniyasi, Rassomlar,

fotograflar, dizaynerlar orasida hozirgacha mashhur bo’lgan «Photoshop — 1.0»

muallifini e’lon qildi.

Photoshop dasturi bugungi kunda, «kompyuter grafikasi» sohasi bo’yicha eng

oldingi o’rinda turibdi va mustaqil dastur bo’lib ajraldi. Biz foydalanayotgan

Adobe Photoshop dasturining boshlanishi ancha ilgari bo’lgan. Hozir 41 ta muallifi

e’lon qilingan dasturni aslida aka-uka Jon Noll va Tomas Nollar boshlab bergan.

Ularning otasi fotograf bo’lib, ular yerto’lada joylashgan fotolabaratoriyada otasiga

yordam berar edilar. Tomas nur va rang kontrastini o’rgandi. Jonn esa eski

«Apple» da ishlashga qiziqardi. 1984-yilda Aka-uka Nollarga otasi dastlabki

Macintosh olib berdi. Uning imkoniyatlarining ko’pligi shu dasturni tuzishga sabab

bo’ldi va ularga millionlab dollar foyda keltirdi.

Dasturning Boshlanishi

1987-yilgacha Jonn Noll «Lucasfilm» firmasining Industrial Light and Magic

(ILM) bo’limida «Stars Wars» ga maxsus effektlar tayyorlashda ishlar edi. Tomass

bu vaqtda «Tasvirlar bilan ishlash» to’g’risidagi nomzodlik dissertatsiyasini

yozayotgan edi. Tomassning Apple Mac plus monitorli kompyuteri «Grayscale

Images» tasvirini namoyon qilmadi. Tomass vaziyatni o’zgartirish uchun yangi

dastur tuzishga kirishdi.

Qizig’i shundaki, Industrial Light and Magic (ILM) da Jon ham tasvirlarni qayta

ishlash bilan shug’ullanardi. Akasini muvaffaqiyatlarini ko’rgan Jon birga

ishlashni taklif qildi. Jon o’zining «Kompyuter grafikasi asoslari» kitobida
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shunday yozadi:«Men Tomas ishlarining natijasini ko’rganimda, Pixar

studiyasidagi tasvirlarni qayta ishlash dasturiga o’xshashligini ko’rib hayron

qoldim». O’shandan boshlab biz birga ishlab, murakkab va mukammallashgan

Display dasturini tuzdik. Oradan ko’p vaqt o’tmay Jon yangi sotib olgan rangli

ekranli Macitntosh II kompyuteriga Display dasturini ko’chirishni taklif qildi. Jon

display dasturida ranglar gammasi korreksiyasi, import, fayllarni har xil

formatlarda saqlash va boshqalarni o’ylab topdi.

Dastur ustida ishlash Tomasni dissertatsiya yozishdan chalg’itdi, lekin u shunda

ham xursand edi. Hech qancha vaqt o’tmay Tomas tasvirlarni bir qismini ishlov

berishni yangi usulini o’ylab topdi va ishlov berish asboblar to’plamini tuzdi.

Keyinchalik bular «Plug-ins» deb ataldi. Keyinchalik tonlarni sozlash-(Levels),

balansni boshqarish funksiyasi, ranglar va to’yinishni boshqarish (Hue and

Saturation) ishlab chiqildi. Bu imkoniyatlar Photoshopda dastlabki qadam bo’ldi.

O’sha davrda bunday funksiyalar faqat maxsus dasturlarda bo’lgan. Ular esa faqat

labaratoriyalarda yoki Industrial Light and Magic (ILM) da bo’lgan.

1988-yilda «Display»ni «ImagePro» deb nomi o’zgartirildi. Dastur o’sha davrda

juda zamonaviy edi. Jon bu dasturni sotib, pul ishlashni o’ylar edi. Tomas esa unga

qarshi chiqdi. Bundan tashqari Tomas o’z dissertatsiyasini tugatmagan, to’liq

ishlangan dasturni tuzishga ancha vaqt va mehnat kerak edi. Ular shunga o’xshash

dasturlarni analiz qilishib, o’z dasturlari «Image Pro’ ni boshqalardan oldinga o’tib

ketganligini aniqlashdi.

“Image Pro” dan „Photoshop“ ga o’tilishi

Dasturni moliyalashtirish boshlandi. „Photoshop“ atamasi qayerdan paydo

bo’lganligini hech kim bilmaydi. Dastur namoyishi vaqtida nashriyotchila

tomonidan „Photoshop“ deb nomlangan degan gap bor. Dastlabki versiyalarda

ekranlarda Photoshop ko’ringanligi hozirda bizda „ExTraneous CapitaliSation“

ko’ringanday.Qizig’i shundaki, ko’p dastur tuzuvchilar o’z yo’nalishlarini

Photoshop tomonga burdilar va bunday dasturlarni mustaqil ishlab chiqa
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boshladilar.

Faqatgina bitta kompaniya Photoshopni sotib olishga kuchi yetar edi. Bu

kompaniya hozirda bizga mashhur bo’lgan „Adobe“ kompaniyasi edi. Lekin

masalani hal qilishgacha hali ancha bor edi. Barneyscan skanerlarini ishlab

chiquvchilar aka-ukalarga Photoshopni o’z mahsulotlari komplektida sotishni taklif

qilishdi. Natijada 200ta nusxalangan Photoshop Barneyscan XP savdo belgisi

ostida tarqalib ketdi.

Yaxshiyam Adobe bilan kelishuv uzoq davom etmadi. Tez orada Jon o’z dasturiga

e’tiborni jalb qilish uchun kompaniyaga keldi. U bu yerga kelib Rassel Brounga

o’z dasturini imkoniyatlarini namoyish qildi. Keyin Photoshop Art-director ga

namoyish etildi. Direktorga ma’qul bo’ldi va tezda sotib olish kerakligini aytdi.

Aobe tomonining soddaligidanmi yoki aka-ukalarning ehtiyotkorligidanmi dastur

to’la sotilmadi, faqat litsenziyalandi. Shuning uchun, dasturdan keladigan gonorar

aka-ukalarga tegishli bo’lib qoldi.

Hammasi juda yaxshi borar edi. Lekin aka-ukalar bu muvaffaqiyatlar bilan to’xtab

qolishmadi. Oldinda juda ham o’gir ish-Photoshop 1.0 rasmiy versiyasini ishlab

chiqish turar edi. Tomas dasturni natijaviy kodlash ustida ishladi. Bu vaqtda Jon

esa Plug-ins ni kengaytirish ustida ishlar edi. Bu esa Adobe xodimlarini

hayratlantirdi. Ular bunda ayyorlik va aldashni ko’rishdi.

Qizig’i shunda ediki, ba’zi qoidalarga qattiq rioya qiluvchi xodimlar, Photoshopni

kengaytirish standartlarga to’g’ri kelmaydi va yaxshi natija bermaydi deb fikr

bildirishdi. Boshqalar esa, uni to’g’ri ishlatish ko’p foyda berishini aytishdi.

Dasturni tugatishni oxirgi bosqichlarida ham Tomas uni o’zgartirish va

mukammallashtirishga vaqt va kuch topdi. Photoshopning tarafdorlari Jon va

Rassel Brounning qo’llab quvatlashi va Adobe ning qarorlari natijasida 1990-yil,

fevral oyida Adobe Photshop rasmiy versiya sifatida chiqdi.
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So’zsiz 1-versiyaning chiqishi, ko’p xatolarga qaramasdan muvaffaqiyatli bo’ldi.

Adobe kompaniyasi Photoshopning hammabopligini isbotlab berdi, lekin u o’sha

vaqtda maxsus dastur tuzuvchilar uchun ishlab chiqilgna edi.

Adobe kompaniyasi: Photoshop yordamida shunday natijaga erishishish

mumkinligini, bunday natijaga ilgari faqat bir necha ming dollar turadigan

professional, maxsus dastur asosidagina erishish mumkin ekanligini ta’kidladi.

O’sha vaqtda Photoshopning narxi 1000$ bo’lishiga qaramasdan, uning eng katta

raqobatchisining narxi 1995$ turadigan Letraset’s ColorStudio dasturi edi.

2.0 versiyani ishlab chiqish bosqichida Adobe dasturchilar shatitini kengaytirdi.

Dasturga Bezye egri chizig’ini kiritish uchun Mark Gamburgni taklif qildi. Bu

vaqtda Photoshopda yangi imkoniyatlar ochildi: Pen tool, ikki tonli tasvirda

ishlash, Illustratordan ba’zi tasvirlarda import va Rasterize. Bulraga yana CMYK

qo’shildi. Photoshop uchun kasb bozorining ochilishi, poligrafiya xizmatlari

Adobe kompaniyasi uchun juda qo’l keldi. Sotish bo’yicha birinchi menedjer

Steven Gutman beta-versiya dasturlariga kodli nomlar taklif qildi. Bu odat shu

kungacha davom etyapti. 1990-yilda chiqqan ‘Fast Eddy’ beta-versiya 2.0 ning

kodli nomidir.

Photoshop uzoq vaqt, asosan Macintosh platformasida ishladi. Lekin uning

muvaffaqiyatga erishishiga Grafika bozorida paydo bo’lgan Windows kafolatlab

berdi. Yangi platformaga versiya ishlab chiqish oson ishlardan emas edi-buning

uchun Brayan Lepkin boshchiligida yangi guruh tuzildi. Ko’p miqdorda yangi

kiritmalar, masalan 16bitli fayl ishlab chiqarilishiga qaramasdan, bular faqat 1993-

yil 2.5.1 versiyalarida paydo bo’ldi.

3.0 versiyadagi musiqa guruhi uchun ishlangan 3 albom ham muvaffaqiyatga

erishishi yoki butunlay muvaffaqiyatsizlikka uchrashi mumkin edi. Omad Brayan

Lepkin boshqarayotgan guruh tomonida bo’lib, ular qavatlar(Layers) ni

ta’minlovchi dasturni rivojlantirdilar
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Layers ni ko’pchilik qo’llab-quvatladi, chunki u dasturning asosiy funksiyasini

bajarar edi, u tez orada, ko’pgina rassom va dizaynerlarni o’ziga jalb qildi. Layers

o’sha vaqtda juda mukammal emas edi. HSC keyinchalik Meta creations Live

pictures nomli tasvirlarni qayta ishlash dasturini ishlab chiqdi, u ham shunday

texnologiyani qo’llardi. Meta Creations juda katta xatoga yo’l qo’ygani shundaki,

ular Live Picturesga juda baland narx qo’yib yuborishdi va Photoshop3.0

versiyasiga raqobatchi qolmadi.

Keyingi versiyalarda Layers ga o’xshash katta o’zgarishlar bo’lmadi, lekin dasturni

mukammallashtirish davom etdi. Photoshop 5.0 versiyasida, ranglarni boshqarish

va History Palette kiritldi. Ularning tasirida dasturning san’at imkoniyatlari oshdi.

Photoshop 5.5 versiyasining chiqishi bilan katta o’zgarish bo’ldi. Photoshop

komplektida Image Ready paydo bo’ldi va u web uchun grafikalarni ishlovchi

yangi funksiyalarni ochib berdi. Photoshop 6.0 versiyasida Layer Styles va matnni

harakatlanishini boshqarish imkoniyatlari paydo bo’ldi. Photoshop 7.0 versiyasida

Healing brush paydo bo’ldi.

Uzoq vaqt dastur bozorida lider pozitsiyasini ushlab turgan Adobe o’z dasturini

mukammallashtitaverdi. Hozirgi kunda Photsohop Creative Suite 2 (CS2) и

Creative Suite 3 (CS3) paketlar tarkibida turibdi.

Yaxshiyamki, dasturni takomillashtirish to’xtamadi va hozir ham davom etyapti.

Axborot dasturlari bozorida konkurensiyaning balandligi sababli, axborot

dasturlarini taqdim etuvchilarning ko’pchiligi Photoshopni bepul ba’zi turlaridan

masalan, Paint shop Proni arzon narxda havaskorlar va uyda ishlovchilar uchun

taqdim etishdi. Adobe kompaniyasi Photoshopning yetarlicha imkoniyatlari

bo’lgan, Photoshop Elements 4.0 versiyasini ishalb chiqdi.

Kelajakda nima bo’ladi…? Afsuski, Adobe bu haqida anons bermayapti.

Photoshop Adobe kompaniyasining tojidagi qimmatbaho toshdir, shuning uchun

uning kelajakdagi rejalari sir tutilyapti. Lekin har zamonda kompaniya Photoshop

kelajagi haqida bir luqma tashlab qo’ymoqda. Video va raqamli tasvirlar ishlash
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bo’limining Vitse-Prezidenti Brayan Lemkin 64-bitli versiyasi va Apple’s

CoreImage texnologiyasini qo’llab-quvatlashini aytdi.

Ular dasturning imkoniyatlarini ko’paytiradi. Yana Photoshop bilan Illustrator

birlashadi degan mish-mishlar yuripti. (Men uni intizorlik bilan kutyapman.)

Nima bo’lishidan qat’iy nazar Tomass Noll proyektni davom etishda qatnashadi.

Tomass Noll hozirda Photoshop ishlab chiqarilishi bilan bevosita shug’ullanmasa

ham, yangiliklardan doim xabardor bo’lib turibdi. Plugin, Adobe camera raw yangi

versiyalarini ishlashda va Adobe kompaniyasining forum va diskussiyalarida

qatnashib turibdi.

2.2 Adobe Photoshop grafik muharriri muhiti

Adobe PhotoShop dasturni ishga tushirish uchun Windows ning asosiy

menyu tugmasini bosamiz, uning ichidan Programmı bulimini tanlaymiz va

Adobe nomli guruxdan Adobe PhotoShop nomli buyrukni tanlaymiz. Natijada

kuyidagi oyna xosil kilinadi:

   Ushbu oynaning yukorisida menyu satri joylashgan. U kuyidagi kismlardan

iborat:  Fayl (File), Pravka (Edit), Risunok (Image), Sloy (Layer),

Vıdelenie (Select), Filtr  (Filter), Vid (View), Okno (Window) va

Pomosh (Help).

Uning tagida ish kurollarning xususiyatlari soxasi  (Panel Svoystv -

Options bar) joylashgan. Agar ushbu soxa ekranda yuk bulsa uni  Okno

  117

(Window) menyusidagi  Svoystva (Options) buyrugi  ёrdamida ekranga

chikarishimiz mumkin.

Xususiyatlar soxasi pastida ish  soxasi joylashgan bulib, uning chap

tomonida ish kurollar soxasini (panel İnstrumentov - Toolbox) kurishimiz

mumkin.  İsh soxasining ung tomonida xar xil  ёrdamchi soxalar joylanishi

mumkin:  Sloi - Layers,  İstoriya - History, Kanalı - Channel, Tsveta -
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Color, Stili - Style, Svoystva kisti - Brushes, Svoystva shrifta -

Character va xokazo. Ushbu soxalarni xam  Okno(Window) menyusidagi

buyruklari  ёrdamida ekranga chikarishimiz va ekrandan olib tashlashimiz

mumkin.

Ёrdamchi soxalarni kichkinashtirishimiz xam mumkin. Buning uchun

soxaning yukorisidagi kichkinalashtirish (svernut) tugmasidan foydalanamiz.

Ёrdamchi soxalarda bizga eng kerakli bu ish kurollar soxasi  (panel

İnstrumentov -Toolbox) va katlamlar soxasi  (Sloi- Layers). Yangi

PhotoShop faylini yaratish  ёki eski faylni kayta ochish uchun menyu

Fayldagi Sozdat va Otkrıt buyruglaridan foydalanamiz. Fayl yaratganimizda

ekranda kuyidagi oyna xosil kilinadi

Bu oynada uning nomini  Name, turini  Preset, enini  Width, buyini

Height, sifatini  Resolution, ranglar xolatini, orka rangini tanlashimiz kerak
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buladi. Xammasini tanlagach  OK tugmasini bosamiz va natijada ekranda

yangi bush ish soxa xosil kilinadi.

2.3 Adobe Photoshop dasturning ish qurollari.

Dasturda ishlash uchun ёrdamchi ish kurollar soxasidagi tugmalar bilan

tanishalik. U ekranning chap tomonida joylashadi. Agar u ekranda yuk bulsa u

xolda  Windows (Okna) menyusidagi  Panel  İnstrumentov - Toolbox buyrukni

ishga tushirishimiz kerak.

Turtburchak soxa tanlash - Rectangular marquee (pryamougolnaya

oblast) - [M] - ish soxasidagi aktiv katlamda turtburchak soxani tanlash.

 Aylana soxa tanlash - Elliptical marquee (ellipticheskaya oblast) - [M] -

ish soxasidagi aktiv katlamda ellips soxani tanlash.

Aloxida satr soxa tanlash - Single row marquee (stroka pikseley) - [M] -

ish soxasidagi aktiv katlamda bitta satrga teng soxani tanlash.

Aloxida ustun soxa tanlash - Single column marquee (stolbets pikseley) -
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[M] - ish soxasidagi aktiv katlamda bitta ustunga teng soxani tanlash.

Tanlangan soxaga kushimcha soxa kushish uchun SHIFT tugmasini bosib

turib ushbu tugmadan kayta foydalanamiz. Agar esa ALT tugmasidan

foydalanib soxa tanlasak, u xolda tanlangan soxadan olib tashlash manosini

bildiradi.

     Xususiyatlar satrida kuyidagilar aktiv buladi:

•  SHIFT va ALT - tugmalar xarakatlariga uxshash xolatlarni tanlash

•  Feather - soxasi ёrdamida tanlangan soxa chegaralarini kalinligi.

•  Style - soxasi  ёrdamida tanlash xolatini tanlaymiz.  Normal -

cheksiz soxa,  Constrained Aspect Ratio -  ёnlari kursatilgan

proportsiyalardagi soxa tanlash,  Fixed size -  ёnlari kursatilgan

kattaligidagi soxa tanlash.

Lasso - Lasso (Lasso) - [L] - ixtiёriy soxani tanlash. Agar tanlaganimizda

ALT tugmasini bosib tursak, u xolda bizning lasso kupburchak lassoga uxshab

soxa tanlaydi va ALT tumasini bosganimizda tanlangan soxa berkiladi.

Kupburchak lasso - Polygonal lasso (Mnogougolnoe lasso) - [L] -

kupburchak soxani tanlash. Tanlangan soxani berkitish uchun ёki sichkoncha

bilan ikkitali bosish kerak, ёki CTRL tugmasini bosi kuyvorishimiz kerak buladi.

Magnit lasso - Magnetic lasso (Magnitnoe lasso) - [L] - uxshash ranglar

buyicha soxa tanlash. Kompyuter tanlagan nuxtani bekor kilish uchun

Backspace tugmasini bosish kerak.

     Tanlangan soxaga kushimcha soxa kushish uchun SHIFT tugmasini bosib

turib ushbu tugmadan kayta foydalanamiz. Agar esa ALT tugmasidan

foydalanib soxa tanlasak, u xoldatanlangan soxadan olib tashlash manosini
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bildiradi.

     Xususiyatlar satrida kuydagilar aktiv buladi:

•  SHIFT va ALT tugmalar xarakatlariga uxshash xolatlarni tanlash

•  Feather soxasi ёrdamida tanlangan soxa chegaralarini kalinligi

•  Anti-Aliased optsiyasi tanlangan soxaning chegaralar rangini

kuzga kurinmas kilib bir biriga moslash

•  Width - tanlangan soxaning chegaralar kalinligini uzgartirish

•  Edge Contrast - magnit lassoning sezguvchanligini uzgartirish

•  Frequency - magnit lassoning avtomatik ravishda kuyiladigan

nuxtalar urtasidagi masofa

Sexrli taёkcha - Magic wand (Volshebnaya palochka) - [W] - bir xil

rangli soxani tanlash.

Tanlangan soxaga kushimcha soxa kushish uchun SHIFT tugmasini bosib

turib ushbu tugmadan kayta foydalanamiz. Agar esa ALT tugmasidan

foydalanib soxa tanlasak, u xoldatanlangan soxadan olib tashlash manosini

bildiradi.

     Xususiyatlar satrida kuydagilar aktiv buladi:

 •  SHIFT va ALT tugmalar xarakatlariga uxshash xolatlarni tanlash

• Tolerance - soxa tanlashda sexrli taёkchaning sezguvchanligini

uzgartirish

•  Anti-Aliased optsiyasi tanlangan soxaning chegaralar rangini

kuzga kurinmas kilib bir biriga moslash

•  Contiguous optsiyasi tanlangan soxa bita umumiy bulishini  ёki

bir nechta kismdan iborat bulishini taminlaydi

•  Use All Layers optsiyaci sexirli taёkchaning soxa tanlaganligi

xama katlamlarga tegishli  ёki fakat asosiy bulgan katlamga

tegishligini taminlaydi

     Tanlangan soxa ustidan biz xar xil xarkatlarni bajarishimiz mumkin.

Masalan xotiraga kirkib olib  ёki nusxa olib yangi katlamga uni kuyishimiz
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mumkin. Ёki uni xajmini uzgartirish va aylantirishimiz mumkin. Va nixoyat uni

ish soxa buylab siljitishimiz mumkin.

Xarakatlanuvchi - Move (peremeshenie) - [V] - tanlangan soxani ish

soxa buylab xarakatlantirish.

Agar ALT tugmani bosib xarakatlanishni boshlasak, u xolda tanlangan

soxaning nusxasi olinib u xarakatlanadi. Agar esa SHIFT tugmasidan foydalansak, u

xolda tanlangan soxa fakat vertikal va gorizontal xarakatlanadi. Tanlangan soxani

klaviaturadagi yunalish strelkalari  ёrdamida xam xarakatlantirish mumkin, shunda

xar bita strelka bosilganida, tanlangan soxa 1 pikselga siljiydi.

     Xususiyatlar satrida kuydagilar aktiv buladi:

•  Auto Select Layer soxasi - sichkoncha ёrdamida aktiv bulmagan

katlamni aktiv kilish.

•  Show Bounding Box - tanlangan soxa chegaralarida ramka xosil

kilish. Ushbu ramka  ёrdamida rasmni chuzish va aylantirish

mumkin buladi.

 Kadrlovchi - Crop (Kadrirovanie) - [C] - faylning kerak emas kismlarni

kirkib olib rasmni kichkinalashtirish. Buning uchun kerakli soxani tanlab

ENTER tugmasini bosamiz, agar tanlanishni bekor kilmokchi bulsak ESC

tugmasini bosshimiz kerak.

Bulish pichokchasi - Slice (Narezka) - [K]  - tasvirni bir nechta kismga bulib

chikib uni  İnternetda kismlarga bulingan xolatda chikarish uchun

tayёrlab kuyadi.

    Bulinishlarni sozlash - Slice select (Vıbor moduley) - [K]  - bir nechta

kismga bulingan tasvirni sozlash (bulaklarni chuzish).
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     Xususiyatlar satrida kuydagilar aktiv buladi:

•  Style soxasi  ёrdamida tanlash xolatini tanlaymiz.  Normal  cheksiz soxa,

Constrained Aspect Ratio -  ёnlari kursatilgan proportsiyalardagi soxa tanlash,

Fixed size -  ёnlari kursatilgan kattaligidagi soxa tanlash.

•  Show Slice Numbers - kismlarni nomerlarini kursatish  ёki kursatmaslik

•  Line Color - bulinish chegaralarini rangini uzgartirish

•  Promote To User Slice - bulinishlarni avtomatik gorizontal va vertikal davomlash

•  Slice Options tugmasi - bulakchaning xususiyatlarini uzgartirish va sozlash.
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Amaliy qism
Deraza oynasidagi yozuv effekti

Buning uchun bizga ikkita rasm kerak bo’ladi, ya’ni terlagan deraza oynasi
rasmi va orqa fon uchun qo’shimcha rasm:

Keyin birinchi rasmimiz qatlamiga o’tib quyidagi buyruqni bajaramiz:

Image > Adjustments > Desaturate

Bu buyruq bajarilgach rasmimiz oq-qora rasmga aylanadi va Image >
Adjustments > Levels buyrug’ini bajargan holda quyidagi muloqot oynasida
kerakli sozlamarni o’rnatimiz:
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Ikkinchi rasmimizga filtr ta’sir ettiramiz, ya’ni Filter > Blur > Gaussian Blur
buyrug’ini bajaramiz va quyidagicha sozlaymiz:

Brush Tool uskunasi tanlaymiz va
qiymatini 30px ga teng qilgan holda «Life is
Good :)» matnini yozamiz:
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Natija quyidagicha:

Keyin uskuna qiymatini 9px ga qo’yib kerakli qismlarini chizamiz:

«Прозрачность» qiymatini 60-70% ga teng qilamiz и «layer mode» bo’limida
«Soft Light» rejimini tanlaymiz va yakuniy natijaga erishamiz:

Fotosurat akvarelda chizilganlik effekti
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Photoshop dasturi ishga tushgach, o’lchamlari 1920x1200 pikelga teng bo’lgan
yangi document hosil qilamiz:

Yangi qatlam yaratamiz va uni oq rangga bo’yaymiz, Filter>Texture>Texturizer
buyrug’ini bajaramiz:

Keyin kerakli bo’lgan rasmni ochamiz va tekstura foni sifatida quyidagicha rasm
ishlatamiz, ya’ni uni Photoshop dasturi ochib, yangi qatlam ratamiz va unga
tekstura rasmimizni qo’yamiz, qatlamlarni guruhlashtirib Layer>Layer Mask>Hide
all buyrug’ini bajaramiz, natija quyidagicha:
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Guruhlashtirilgandan keyin tekstura foni oxirgi qatlam sifatida qo’shilgani
uchun uning tagidagi rasm ko’rimay qoladi, Brush Tool uskunasi tanlaymiz va
ehtiyotlik bilan akvarel kistochkasi effekti yaratamiz:
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Yangi qatlam yaratamiz va pushti, ko’k va sariq ranglarni tanlagan holda Brush
Tool uskunasi yordamida qo’shimcha effektlar beramiz:

Keyin rasmimizni tanlaymiz va Image>Adjustment>Photo
Filter buyrug’ini bajaramiz, ochilgan muloqot oynasida
“Warning Filter” qiymatini 85% ga, “Density” qiymatini 55%
ga teng o’rnatamiz va yakuniy natijaga erishamiz:
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Rasmda dekorativ naqsh effektini hosil qilish

Buning uchun birinchi navbatda naqshni yaratib olish kerak, yangi document
hosil qilamiz:

Keyin qatlam ustiga ikki marta bosgan holda, qatlamga quyidagi sozlamalarni
o’rnatamiz:
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Kerakli rasmimizni Photoshop dasturida ochib olamiz:
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Edit > Fill buyrug’ini bajaramiz va ochilgan muloqot oynasida kerakli
sozlamalarni o’rnatamiz, ya’ni yuqorida hosil qilgan naqsh bo’lakchasini, tekstura
sifatida ishlatish uchun tanlaymiz:

Natija quyidagicha bo’ladi:

Qatlam ko’rinish rejimini “Multiply” ga o’zgartiramiz:
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Layer > Levels buyrug’ini bajaramiz va: Ctrl + Alt + G bosamiz va maska
ta’sir ettiramiz, keyin qatlam ustiga sichqonchaning chap tugmasini ikki marta
bosib qatlam xususiyatlari oynasini chaqiramiz va unda kerakli sozlamalarni
o’rnatamiz:

Yakuniy natija quyidagicha:
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Xulosa
Hozirgi kunga kelib informatsion texnologiyalar rivojanib ketishi bilan,

dasturiy ta’minot ham orqada qolgani yo’q. Shu jumladan grafik muharrirlarni

oladigan bo’lsak, har xil vazifalarga mo’ljallangan rasmlarni qayta ishlash, har xil

effektlar yaratish, animatsiyalar hozil qilish, foto va video montaj texnologiyalari,

2D va 3D loyihalashtirish dasturlari yaratilib, ularning yangi turlari chiqmoqda.

Rastrli grafika bilan ishlashda eng mashhur grafik muharrirlardan biri, bu

Adobe kompaniyasining Photoshop dasturidir. Bu dastur juda ko’p funksional

imkoniyatlarga ega bo’lib, professional dizayner qo’lida juda ko’p natijalarga

erishish mumkin.

Kurs ishini bajarish davomida Adobe Photoshop grafik muharrining

imkoniyatlari bilan tanishdim, rasmlarni qayta ishlash texnologiyalari, ularga har

xil effektlar berish va shunga o’xshash ko’pgina qiziqarli bilimlarga ega bo’ldim

va amaliy ishlar bajarilishi davomida bilimlarimni yanada mustahkamladim.
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Foydalanilgan adabiyotlar

1. S.S.Yoqubov, B.A.Ravshanov «Adobe Photoshop grafik muharriri
imkoniyatlari» 2013.

2. Informatika.  Akademik  S.S.G’ulomov  umumiy  tahriri  ostida.
Darslik. Toshkent. – TDIU, 2007.

3. R.Avazov,  B.Lochinov.  “Grafik muharrirlari bilan tahishuv”
O’quv qo’llanma. 2009.

4. B.E.Yuldashev, M.T.Maxkamov, M.Sirojiddinov. “Kompyuter
grafikasi asolslari”.  O’.R.F.A. “Fan”, 2008 y

 Foydalanilgan web-saytlar va electron resurslar

1. http://www.ziyonet.uz – o’quv portali
2. http://www.google.com – qidiruv tizimi
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